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Preface

elcome to SQL*Plus for Windows NT/95, Release 3.3. This guide
contains important information to help you get started with SQL*Plus
for Windows NT or SQL*Plus for Windows 95. It covers the following
topics:

• audience

• how this guide is organized

• conventions used in this guide

• reader comments

Attention:  This guide incorporates information for two separate
Oracle products — SQL*Plus for Windows NT and SQL*Plus for
Windows 95 — into one book, SQL*Plus User’s Guide for Windows
NT/95. Its title is not intended to suggest a single SQL*Plus product
that will run on both platforms.
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Audience

This guide is for all users who wish to install and use SQL*Plus, Oracle
Corporation’s SQL extension, in the Microsoft Windows NT or
Windows 95 graphical environment.

Prerequisites

You should be familiar with your computer and its operating system.
For example, you should know the commands for deleting and copying
files and understand the concepts of the search path, subdirectories, and
path names.

You should also understand the fundamentals of the Microsoft
Windows platform that you are using, such as Program Manager and
File Manager in Windows NT or Taskbar and Windows Explorer in
Windows 95, and the elements of an application window.

How to Use this Guide

This guide is a companion piece to the SQL*Plus User’s Guide and
Reference and the SQL*Plus Quick Reference included with your SQL*Plus
package. Use this guide to learn how to install SQL*Plus for Windows
NT/95, then work through the SQL*Plus examples in the SQL*Plus
User’s Guide and Reference.

As you work through the examples in the SQL*Plus User’s Guide and
Reference, refer to this guide for information about the SQL*Plus menu
items and the use of SQL*Plus in the Windows NT/95 environment.

How this Guide is Organized

This guide consists of four chapters and one appendix:

Chapter 1   Introduction to SQL*Plus
Provides an introduction to SQL*Plus for Windows NT or SQL*Plus for
Windows 95.

Chapter 2   Installing SQL*Plus for Windows NT/95
Details the procedures for installing SQL*Plus for Windows NT or
SQL*Plus for Windows 95.



 vPreface

Chapter 3   SQL*Plus Menus
Describes the SQL*Plus for Windows NT and SQL*Plus for Windows 95
menu commands.

Chapter 4   SQL*Plus in the Windows NT/95 Environment
Contains operating system–specific information and documentation
cross–references found in the SQL*Plus User’s Guide and Reference.

Appendix A   Customizing Operating System Parameters: 
    The Windows Registry

Lists the parameters used by SQL*Plus in the Windows NT/95
environment and describes how to customize your Oracle configuration
by changing parameter values.

Conventions Used in This Guide

The following typographical conventions are used in this guide:

Text in courier font indicates commands that you
must enter exactly as shown.  Text typed on a PC is
not case–sensitive, unless noted otherwise.

Keys indicated in the text are also shown in courier
font, for example, CTRL+C.

Uppercase characters within the text represent
command names, SQL reserved words, and
keywords.

Lowercase characters in a command statement
represent a variable.  Substitute an appropriate
value.

In commands, punctuation other than brackets and
vertical bars must be entered exactly as shown.

A backslash before a directory name indicates that
the directory is a subdirectory.

C:\> represents the DOS prompt. Your prompt may
differ and may, at times, reflect your current
subdirectory.

This term refers to Microsoft DOS (MS–DOS) and
Novell DOS (DR DOS).

Courier font

UPPERCASE

lowercase

Punctuation

\DIRECTORY

C:\>

DOS



A Note on Directory
Names
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This guide refers to the directory names used in the default installation
procedures. If you change the names of any of the Oracle directories
substitute those names for the ones in this guide.

This guide references the following Oracle documentation:

• SQL*Plus User’s Guide and Reference

• SQL*Plus Quick Reference

• Oracle7 Server Messages

• Oracle7 Server SQL Reference

• PL/SQL User’s Guide and Reference

These documents (and this guide) are available in Adobe Acrobat
format. An Adobe Acrobat viewer is automatically installed along with
on your system. To view them, start Adobe Acrobat and choose the
document(s) you want to view and/or print.

Reader’s Comments

We value and appreciate your comments as an Oracle user. At the back
of this guide is a Reader’s Comment Form. We encourage you to use
this form to tell us what you like and dislike about this (or other) Oracle
manuals. If the form is missing, or if you would like to contact us, please
use the following address.

Workgroup Solutions Documentation Manager
Workgroup Solutions Division
Oracle Corporation
500 Oracle Parkway, Box 659107
Redwood Shores, CA 94065
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1 – 1Introduction to SQL*Plus

Introduction to
SQL*Plus

his chapter provides the following information to help you get
started with SQL*Plus for Windows NT/95:

• overview of SQL*Plus

• using SQL*Plus in Windows NT or Windows 95

Attention:  This guide incorporates information for two separate
Oracle products — SQL*Plus for Windows NT and SQL*Plus for
Windows 95 — into one book, SQL*Plus User’s Guide for Windows
NT/95. Its title is not intended to suggest a  single SQL*Plus product
that will run on both platforms.
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Overview of SQL*Plus

You can use the SQL*Plus (pronounced “sequel plus”) program in
conjunction with the SQL database language and its procedural
language extension, PL/SQL. The SQL database language allows you to
store and retrieve data in an Oracle database. PL/SQL allows you to link
several SQL commands through procedural logic.

SQL*Plus enables you to manipulate SQL commands and PL/SQL
blocks, and to perform many additional tasks as well. Through
SQL*Plus, you can:

• enter, edit, store, retrieve, add run SQL commands and PL/SQL
blocks

• format, perform calculations on, store, and print query results in
the form of reports

• list column definitions for any table

• access and copy data between SQL databases

• send messages to and accept responses from an end user

SQL*Plus provides a command line interface in addition to the GUI
version of SQL*Plus.

As a SQL*Plus user, you have access to the command–line functionality
that is available with the character–mode version of SQL*Plus, as well as
the convenient menu–based features of Windows GUI application. For
instance, you can select SQL*Plus menu items to perform tasks such as
these:

• saving and opening SQL scripts

• copying and pasting text to and from the Windows clipboard and
the SQL*Plus application window

• invoking a Windows text editor, such as Notepad

• searching for text in the SQL*Plus application window

• selecting parameters from a dialog box to customize the SQL*Plus
environment
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Basic Concepts

The following definitions explain concepts central to SQL*Plus:

Concepts Definition

command An instruction you give SQL*Plus or the
Oracle  database.

block A group of SQL and PL/SQL commands
related to one another through procedural
logic.

table The basic unit of storage in the Oracle
database.

query A SQL command (specifically a SQL SELECT
command) that retrieves information from one
or more tables.

query results The data retrieved by a query.

report Query results formatted by you through
SQL*Plus commands.

Who Can Use SQL*Plus

The SQL*Plus, SQL, and PL/SQL command languages are powerful
enough to serve the needs of users with some database experience, yet
straightforward enough for new users who are just learning to work
with the Oracle database.

The design of the SQL*Plus command language makes it easy to use.
For example, to give a column labelled ENAME in the database the
clearer heading “Employee”, you might enter the following command:

COLUMN ENAME HEADING EMPLOYEE

Similarly, to list the column definitions for a table called EMP, you might
enter this command:

DESCRIBE EMP
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Using SQL*Plus in Windows NT or Windows 95

Oracle has combined the power of its SQL*Plus command language
with the graphical environment of Microsoft Windows NT and
Windows 95. So, you can install SQL*Plus regardless of the platform you
are using.

As a SQL*Plus for Windows NT or SQL*Plus for Windows 95 user, you
have access to the command–line functionality of the character–mode
DOS version of SQL*Plus, as well as the menu–based features of a
Windows NT/95 application.

For instance, with the menu–based Windows NT/95 application you
can select SQL*Plus menu items to perform tasks such as these:

• saving and opening SQL scripts

• copying and pasting text to and from the Windows NT/95
clipboard and the SQL*Plus application window

• invoking a Windows NT/95 text editor, such as Notepad or
Microsoft Word

• searching for text in the SQL*Plus application window

• changing the size of the SQL*Plus screen buffer

• selecting parameters from a dialog box to customize the SQL*Plus
environment

Other advantages of using SQL*Plus for Windows NT/95 include the
following:

• SQL*Plus for Windows NT/95 is a 32–bit Windows NT/95
application. It is not restricted by Windows 16–bit limitations
(such as Cooperative Multitasking).

• a resizable application window with Windows NT/95 elements,
such as scroll bars, minimize and maximize buttons, and the
control–menu box

• mouse support
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Installing SQL*Plus for
Windows NT/95

his chapter provides installation information for SQL*Plus for
Windows NT/95. It covers the following topics:

• system requirements

• before you installation

• installation

• starting SQL*Plus

• documentation
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System Requirements

This section lists the minimum system requirements necessary to install
and run SQL*Plus for Windows NT/95. Refer to your Microsoft
Windows NT/95 documentation for information on monitor, printer,
and mouse requirements.

• an IBM, COMPAQ, or 100% compatible PC with an 80386
processor or higher

• a CD–ROM drive functioning as a logical drive

• 2 megabytes (MB) of disk space

• 2 MB of available memory in addition to the memory required to
run Windows NT/95

• Microsoft Windows NT Version 3.5 (or higher) or Microsoft
Windows 95

• an Oracle database Version 7.1 or higher

• SQL*Net for Windows NT/95, if you access a remote Oracle
database

Before You Install

Before you install SQL*Plus for Windows NT/95, make sure that you
perform the following tasks:

• Read the Desktop Products Customer Information booklet and return
your registration card to the appropriate support center.

• Review the accompanying Release Notes.

• Install and test your network hardware and software, if
applicable.

• For Windows NT, you must log on as a member of the
Administrators group.

To install SQL*Plus for Windows NT/95, you will use the Oracle
Installer, Version 3. This Installer provides multiple version capability,
which allows you to install and maintain multiple versions of Oracle
products on your system.
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Installation

The SQL*Plus installation consists of two procedures:

1. Set up the Oracle Installer for Windows NT/95 on your hard drive
by starting the Oracle Installer application from the CD–ROM. After
you start the application, the Oracle Installer performs the following
tasks:

• creates the Oracle home directory (by default \ORANT or
\ORAWIN95) and subdirectories

• copies the installation files to the Installer directory in the Oracle
home directory

• configures your system’s environment for Oracle software

2. To install SQL*Plus, use the Oracle Installer to perform the following
tasks:

• create the SQL*Plus and the Required Support Files
subdirectories

• install the Required Support Files

• install SQL*Plus

• create a SQL*Plus icon in the Oracle program group

The following sections give step–by–step instructions for setting up the
Oracle Installer and for installing SQL*Plus.

Setting Up the Oracle Installer

To set up the Oracle Installer, complete the steps in this section.

Note:  If you installed another Oracle Windows NT/95 product
previously, the Oracle Installer is already set up in the hard
drive. Complete the steps in this section, however, to ensure you
use the current release of the Oracle Installer to install SQL*Plus.

You can use any CD–ROM drive that can be attached to the Windows
NT/95 machine as a logical drive to set up the Installer on your hard
drive and install SQL*Plus software. This guide treats the G: logical
drive as the CD–ROM drive, although the Installer and Windows NT/95
will recognize any drive for which you have configured the CD–ROM.

Before running the Oracle Installer from the CD–ROM, be sure you have
read your third–party CD–ROM documentation. Also, refer to that
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documentation if the installed CD–ROM drive cannot copy files to your
hard drive.

Setting Up the Oracle Installer in Windows NT

The following steps describe how to set up the Oracle Installer on your
hard drive in Windows NT. If you already have the latest version of the
Oracle Installer on your hard drive, proceed to the next section,
“Installing SQL*Plus for Windows NT”. If you are not sure you have
installed the latest version of the Installer, proceed with Step 1.

1. Run the installer executable, ORAINST. There are three ways to run
ORAINST for Windows NT.

From the Program Manager

From the Windows NT Program Manager, select “Run” from the File
menu. Enter the path and executable file name, for example:

G:\NT_X86\INSTALL\ORAINST.EXE

Then, press [Enter].

From the File Manager

From the Windows NT Program Manager, choose the File Manager icon.
Select the drive to which the CD–ROM is connected. Choose the NT_X86
directory icon, and then choose the Oracle Installer directory icon.
Finally, choose the ORAINST.EXE file icon.

From the Command Prompt

Choose the Command Prompt icon from the Main Group. Then, type
the following:

C:\>G:

G:\>CD NT_X86\INSTALL

G:\NT_X86\INSTALL>ORAINST

If you are using the Installer for the first time, it prompts you to select a
language.

2. Select a language and choose OK, or press [Enter] to accept the
default language.

3. When you run the Oracle Installer from the CD–ROM, it prompts
you to enter the company name. (Once you have set up the Oracle
Installer on your hard drive, you will not receive this prompt in
subsequent uses of the Oracle Installer.) Type in the company name.

4. If you have already installed Oracle products, the Oracle Installer
prompts you with the existing Oracle directory. Otherwise, the
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Oracle Installer prompts you to enter the drive and directory path
on which the Oracle products will be installed. The default path is
\ORANT on the drive containing the Windows NT operating
system. Choose OK or press [Enter] to accept the default path. If you
want to change the destination drive or directory, type in your
custom path, then choose OK.

5. The Oracle Installer advises you it has included C:\ORANT\BIN in
the “all users” component of the PATH variable in the Windows NT
Registry. Choose OK.

6. If the installation procedure made changes to your operating
system’s initialization files, the Oracle Installer prompts you to log
off and log back on your machine. The Oracle Installer then closes.
Select Log off from the Windows NT File menu.

Repeat Steps 1 through 4.

Setting Up the Oracle Installer in Windows 95

The following steps describe how to set up the Oracle Installer on your
CD–ROM drive in Windows 95. If you already have the latest version of
the Oracle Installer, you can skip these steps and proceed to the next
section, Installing SQL*Plus. If you are not sure you have installed the
latest version of the Installer, proceed with Step 1.

Note:  If you insert a CD–ROM that contains the Oracle
Installer, a dialog box asks if you want to install. If you choose
Yes, it will automatically complete Steps 1 – 6 for you.

1. From the Windows 95 Taskbar, click Start. Choose Run from the
menu list.

The Run dialog box appears.

2. Choose Browse.

3. In the Look in list box, pull down the list box and select your
CD–ROM drive. For example, if the CD–ROM drive is mapped to
G:, select the G: drive.

4. Double–click the Win95 folder.

5. Double–click Setup.

The Run dialog box appears.

6. Choose OK.

7. Read the licensing screens (if they appear). When you are finished,
choose OK.
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If you are using the Oracle Installer for the first time, it prompts you
to select a language.

8. Select a language. Then choose OK, or simply press [Enter] to accept
the default.

9. If your system displays a Welcome screen, choose OK .

The Oracle Installer prompts you to enter the company name. (Once
you have set up the Installer on your hard drive, you will not
receive this prompt in subsequent uses.)

10. Type a company name or accept the default. Choose OK.

If you have already installed Oracle products, the Oracle Installer
prompts you with the existing Oracle directory. Otherwise, it
prompts you to enter the drive and directory path where Oracle
products will be installed. The default path is \ORAWIN95 on the
drive containing  the Windows 95 operating system.

11.  Choose OK to accept the default path. If you want to change the
destination drive or directory, type the custom path, then choose
OK.

The Oracle Installer Software Asset Manager appears.

Installing SQL*Plus

The following directions describe how to install SQL*Plus from either
the Windows NT or the Windows 95 platform.

Installing SQL*Plus from Windows NT

After the Oracle Installer is copied to your hard drive, you are ready to
install SQL*Plus.

The Oracle Installer contains the following windows:

Lists all of the products available from the Oracle for
Windows NT CD–ROM.

Lists all Oracle for Windows NT products installed in your
Oracle home directory.

Provides feedback on the task you are performing.

The Oracle Installer contains an online help facility.  To display help on
the Oracle Installer, select Using Oracle Installer from the Help menu, or
type CTRL+U.

1. In the Available Products window, select SQL*Plus.

Available
Products

Installed
Products

Status
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If no installable products appear in the Available Products window
when you start the Installer, then:

• Choose the From button. The Open dialog box appears.

• Choose the CD–ROM drive letter (for example, G:\) from the
Drives list

• Choose the \NT_X86\INSTALL directory from the Directories
list.

• Select the NT.PRD file, and choose Open.

2. Choose Install to begin installing SQL*Plus.

During installation, a progress bar shows the percentage of the
installation that has completed. Messages are displayed indicating file
names and Installer actions that are being taken. The Installer allows
you to cancel the installation by choosing Cancel during the installation
procedure.

3. When the SQL*Plus for Windows NT installation is complete, the
Installer displays the installed products. Note that “SQL*Plus for
Windows NT” and other products are listed in the Installed
Products window.

Choose Exit from the File menu to exit the Installer.

Installing SQL*Plus from Windows 95

The Oracle Installer Software Asset Manager Window contains two
windows:

Lists all the products available from the Oracle for Windows
95 CD–ROM.

Lists all Oracle for Windows 95 products installed in your
Oracle home directory.

1. Select the SQL*Plus product from the Available Products window.

If no installable products appear in the Available Products window
when you start the Installer, then:

• Choose the From button. The Open dialog box appears.

• Choose the CD–ROM drive letter (for example, G:\) from the
Drives list

• Choose the \WIN95\INSTALL directory from the Directories list.

• Select the WIN95.PRD file, and choose Open.

2. Choose Install.

Available
Products

Installed
Products
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The Oracle Installer automatically installs the Required Support
Files (if not already installed) and SQL*Plus and prompts you to
confirm that the installation is complete.

3. Choose Exit.

Removing Oracle Products

You can use the Oracle Installer to remove Oracle products from your
hard drive. To remove products, follow these steps:

1. Select the product you wish to remove from those listed in the
Installed Products window.

2. Choose the Remove button.

Starting SQL*Plus

Complete the following steps to start SQL*Plus for Windows NT/95:

1. Ensure the drivers and executables needed to initialize a network
connection (remote Oracle database connection only) are loaded.

2. Start Windows NT/95, and log on to your workstation.

3. Double–click the SQL*Plus icon in the Oracle program group. The
Logon dialog box appears.

4. Enter you Oracle username and password.

If you are connecting to a remote Oracle database, enter the
SQL*Net connect string.  (You may enter your username, password,
and connect string in the User Name box.)

Additional Information:  See the documentation for your
SQL*Net products.

Documentation

An online version of this guide is included with this package. The
documentation is in Adobe Acrobat format (Adobe Acrobat reader is
included). You can install the Acrobat files onto your hard drive, or
access them from the CD–ROM. According to the package(s) you
purchased, other documentation formatted for Adobe Acrobat may be
included.
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SQL*Plus Menus

his chapter describes how to start and use SQL*Plus from the
command line interface and use command keys or the following menus:

• using command line SQL*Plus

• using graphical interface SQL*Plus

• File

• Edit

• Search

• Options
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Using Command Line SQL*Plus

Use the following steps to start SQL*Plus command line:

1. If you are using a remote Oracle database connection, initialize and
load the drivers and executables to establish a network connection
before starting SQL*Plus.

2. Open a MS–DOS Prompt session.

3. At the command line prompt, enter

C:\>  SQLPLUS username/password [@connectstring ]

Several keys on your keyboard have special meaning in SQL*Plus:

SQL*Plus Key Name Keyboard Key Name Function

[Return] Enter End a line of input.

[Backspace] Backspace Move a cursor left one
character to correct an
error.

[Pause] Pause Suspend program 
operation and display
of output.

[Resume] Any key Resume program
operation and output

[Cancel] CNTRL+Break Halt program 
operation; return to
the SQL*Plus com-
mand prompt.

[Interrupt] None Exit SQL*Plus and 
return to the host 
operating system.
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Using Graphical Interface SQL*Plus

Use the following steps to start SQL*Plus graphical interface:

1. If you are using a remote Oracle database connection, initialize and
load the drivers and executables to establish a network connection
before starting SQL*Plus.

2. Open the Oracle folder by choosing it.

3. Select the SQL*Plus icon from the program group.

The SQL*Plus Logon dialog box appears.

4. Enter your userid and password. If connecting to a remote Oracle
database, enter the SQL*Net connect string.
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Using the SQL*Plus Windows

After you install and start SQL*Plus as described in Chapter 2,
“Installing SQL*Plus for Windows NT/95,” SQL*Plus displays the SQL
prompt in the SQL*Plus window. The SQL*Plus window contains basic
Microsoft Windows NT/95 elements, such as dialog boxes, pull–down
menus, scroll bars, and minimize and maximize buttons.

To enter SQL*Plus and SQL commands, type them in the SQL*Plus
interface window, then press enter. Enter commands one line at a time.

For more information about the operation of these elements, refer to the
Microsoft Windows NT/95 documentation.

In addition to the functionality provided by the Microsoft Windows
NT/95 elements, SQL*Plus allows you to use the mouse buttons to copy
previously entered SQL commands to the current SQL prompt. To
quickly copy a command, highlight it and hold down the left mouse
button. While holding down the left button, click the right button.
SQL*Plus copies the text.

SQL*Plus assigns the traditional functions to most of the command keys.
However, the following command keys have special functions in
SQL*Plus for Windows NT/95:

Key Function

HOME Top of screen buffer

END Bottom of screen buffer

CTRL+HOME Right side of screen buffer

CTRL+END Left side of screen buffer
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PAGE UP Previous screen page

PAGE DOWN Next screen page

CTRL+PAGE UP Show page on left of current screen page

CTRL+PAGE DOWN Show page on right of current screen page

F3 Find

ALT+F3 Find next

CTRL+C Copy text

CTRL+V Paste text

SHIFT+DEL Clear the buffer
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File Menu

The File menu consists of the following:

The Open option retrieves a previously stored command file. By default,
SQL*Plus for Windows NT/95 assigns the .SQL extension to command
files. You can specify a different extension in the File Name text box.

GET is the command line equivalent of the Open menu item.

The Save menu item includes three options for saving: Save Create; Save
Replace; and Save Append.

Saves the contents of the SQL*Plus buffer in a
command file. By default, SQL*Plus for Windows
NT/95 assigns the .SQL extension to command
files.  You can specify a different extension in the
File Name text box.

The SAVE CREATE clause is the command line
equivalent of the Save Create menu item.

Replaces the contents of an existing file with the
contents of the SQL*Plus buffer.  If the file does not
exist, Save Replace creates the file.

The SAVE REPLACE clause is the command line
equivalent of the Save Replace menu item.

Adds the contents of the SQL*Plus buffer to the file
that you specify.

The SAVE APPEND clause is the command line
equivalent of the Save Append menu item.

After you save a command file, you can do the following:

• retrieve the file with the Open option

• edit the file with the Editor option from the Edit menu

• start or run the file with the START or RUN commands from the
SQL*Plus command prompt

The Save As option stores the contents of the buffer to a command file.
By default, SQL*Plus for Windows NT/95 assigns the .SQL extension to
command file.  You can specify a different extension in the File Name
text box.

SAVE is the command line equivalent of the Save As menu item.

Save Create

Save Replace

Save Append
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The Spool menu item contains two options: Spool File and Spool Off.

Stores query results in a file.  By default, SQL*Plus
for Windows NT/95 assigns the .LST extension to
spool files.  You can specify a different extension in
the File Name text box.

After you spool query results to a file, you can do
the following:

• edit the results with the Editor option from the
Edit menu

• print the file from a Windows NT/95 text
editor

The SPOOL FILE clause is the command line
equivalent of the Spool File option.

Turns off spooling.

The SPOOL OFF clause is the command line
equivalent of the Spool Off option.

The Run option lists and executes the SQL command or a PL/SQL block
currently stored in the SQL buffer.

RUN is the command line equivalent of the Run menu item.

The Cancel option cancels an in–progress operation.

CTRL+C is the keyboard shortcut for the Cancel menu item.

The Exit option commits all pending database changes and closes the
SQL*Plus application Window.

EXIT is the command line equivalent of the Exit menu item.

Edit Menu

The Edit menu consists of the following:

The Copy option copies selected text to the Windows NT/95 clipboard.

After you copy text to the clipboard, you can paste the copied text into
other Windows NT/95 applications, such as Microsoft Excel and
Microsoft Word.

CTRL+C is the keyboard shortcut for the Copy menu item.

Spool File

Spool Off
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The Paste option pastes the contents of the Windows NT/95 clipboard
onto the SQL*Plus command line.

Note:  A maximum of 3625 characters can be pasted from the
Windows NT/95 clipboard onto the SQL*Plus command line
during a single paste operation.

CTRL+V is the keyboard shortcut for the Paste menu item.

The Clear option clears the Windows NT/95 screen buffer and the
screen. The CLEAR SCREEN clause is the command line equivalent of
the Clear menu item.

SHIFT+DEL is the keyboard shortcut for the Clear menu item.

The Editor menu item consists of two options:

Loads the contents of the buffer into a Notepad
window. By default, Notepad saves the file to
AFIEDT.BUF.  You can specify a different filename
by using the Save As option in the Notepad file
menu. You can also specify another editor by using
the Define Editor option.

EDIT is the command line equivalent of Invoke
Editor option.

Additional Information:  See Edit in SQL*Plus User’s Guide and
Reference.

Defines the editor that is invoked when you select
the Invoke Editor option.

To define an editor, select Define Editor, enter the
name of the executable of the editor, such as
WRITE.EXE, and click OK.  Whenever you select
Invoke Editor, SQL*Plus loads the content of the
buffer into the window of the text editor you
specified.

DEFINE _EDITOR is the command line equivalent
of the Define Editor option.

Invoke Editor

Define Editor
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Search Menu

The Search menu consists of the following options:

The Find option looks for a character, word, or a group of characters or
words in the SQL*Plus application window.  When you choose the Find
option from the Search menu (you can also press ALT+F3 for Find),
SQL*Plus starts the search from the top of the displayed screen.  Note
that when SQL*Plus reaches the end of the SQL*Plus session display,
SQL*Plus will not automatically continue searching from the top of the
SQL*Plus session display.

To find text:

1. Display the screen where you want to start the search, using the
Home, End, Page Up,  and Page Down  keys.

2. Select Find and enter the text you want to find.

3.  Select the Case Sensitive check box if you want to match
capitalization exactly.

The Find Next option (you can also press F3 for Find Next)finds the
next occurrence of the search text.

Options Menu

The Options menu enables you to modify environmental elements of
SQL*Plus (Screen Buffer size and SQL*Plus Options).  From the Options
menu, select Environment. The Environment dialog box appears. The
Environment dialog box contains two areas: Set Options, and Screen
Buffer.

The Set Options area provides a list of variables you can choose to
establish aspects of the SQL*Plus environment for your current session,
such as the following:

• setting the display width for NUMBER data

• setting the display width for LONG data

• enabling or disabling the printing of column headings

• setting the number of lines per page

SQL*Plus Version 3.3 allows you to make multiple changes to Options
before clicking the OK button to commit the changes. In previous
versions, you were required to click OK after each individual change.
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Additional Information:  Many new Options have been added
to this version of SQL*Plus. For more information, see the
SQL*Plus User’s Guide and Reference.

To establish an aspect of the SQL*Plus environment:

1. In the Environment dialog box, select a variable from the list box.

2. Depending on the variable you selected, SQL*Plus activates the
Switch region and the Value region. The switch region toggles a
variable on or off. The value region sets the variable to the default
value or the value you specify. Click the switch buttons and enter
the values for each variable you select, then click OK.

The SET command and variables are the command line equivalents of
the options available from the Environment menu items.

The Screen Buffer area settings control the number of characters and
lines SQL*Plus displays.  The SQL*Plus screen buffer can be larger or
smaller than the size of the SQL*Plus application window.  You might
think of the screen buffer as an “invisible window” within the SQL*Plus
application window that determines the amount of data SQL*Plus
displays.  If the screen buffer is larger than the application window, you
can use the scroll bars to view all of the data.

Initially, the size of the buffer is set to display a width of 100 characters
and a length of 1000 lines.  You can increase the number of characters
and lines of Oracle data SQL*Plus displays by changing the values of the
Buffer Width and Buffer parameters in the Screen Buffer dialog box.

When you change the Screen Buffer option, SQL*Plus displays a
warning dialog box to alert you that if you shorten the size of your
screen buffer, some data may not be displayed on your screen.  Click OK
if you want to proceed.

The Screen Buffer dialog box consists of two text boxes: Buffer Width
and Buffer Length.

Buffer Width

Sets the number of characters SQL*Plus displays on one line. If you
enter a number smaller than the length of output data, SQL*Plus
truncates the data to match the buffer width you specified. The default
value of the Buffer Width parameter is 80 characters. You can specify
from 80 to 1,000 characters on one line.

Note:  The Screen Buffer Width should be set greater than or
equal to the linesize option. If it is not, you will receive a
warning about the Screen Buffer Width being too narrow.
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Buffer Length

Sets the number of lines SQL*Plus displays on the screen. If SQL*Plus
displays more lines of data than you specify, the remaining lines of data
will “wrap around” to the top of the screen buffer. The default value of
the Buffer parameter is 100 lines. You can specify from 100 to 2,000 lines
on one screen.

Select or de–select the Support Non–Blocking checkbox to turn
non–blocking support on or off. Turning off this function hides the
Query Cancel dialog box during long queries.
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Customizing Operating
System Parameters: The
Windows Registry

ou can customize your ORACLE configuration by changing the
operating system parameter values defined in the Windows Registry.
This chapter discusses the following topics:

• modifying the Windows NT/95 Registry

• Windows NT/95 Registry parameter descriptions
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Modifying the Windows NT/95 Registry

When you install Oracle products for Windows NT/95, relevant
parameters are created in the Windows NT/95 Registry. You can
examine these parameters using REGEDIT33.EXE (included with
Windows NT) or REGEDIT.EXE (included with Windows 95).
Oracle–specific parameters are located in
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE in the Registry.

Windows NT/95 Registry parameters control such things as the name of
the Oracle home directory, the location of the product preference file,
and the location of the help files. If you use SQL*Net for Windows
NT/95, the  Windows NT/95 Registry parameters also determine the
driver to be used for network communications and the values that
SQL*Net should use for its operating parameters.  See your SQL*Net
documentation for descriptions of Windows NT/95 Registry parameters
that affect the performance of SQL*Net.

When you installed SQL*Plus for Windows NT/95, the Oracle Installer
automatically sets certain parameters in your Windows NT/95 Registry.
The default values for these parameters are listed in this Appendix.
Other parameters must be set manually and are so noted in the
parameter descriptions.

If you change the default value of an Oracle parameter or add a
parameter to your Windows NT/95 Registry, the changes will take effect
whenever SQL*Plus executes a procedure that uses one of these
parameters.  For example, if you copy the SQLUS.MSB file to another
directory and reset PRO15, the parameter that specifies the location of
SQLUS.MSB to that directory, SQL*Plus will look for the file in the new
directory the next time this file is needed.

To set Oracle–specific Windows NT Registry parameters, use the
REGEDIT33.EXE application to edit the Windows Registry.
Oracle–specific parameters are located in
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE.

To edit a parameter, double–click the value of the parameter.

To add a new parameter (for example, SQLNET DBNAME <alias>):

1. Choose the menu item Add Value under the Edit item in the
Windows Registry Editor. The Add Value dialog box appears.

2. Choose the type: REG_EXPAND_SZ

3. Enter the parameter to be set for the Value Name in the dialog box.
The Registry Editor will prompt you for the actual value of the
parameter.
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4. Enter the parameter value, then press the Enter key, or click the OK
button.

Note:  Do not use the equals sign (=).

Example:

To add a new SQLNET alias (MYDB), provide the value name as:
SQLNET DBNAME MYDB, REG_EXPAND_SZ, then insert the value for
the connect string for the alias (for example, P:MY_CORPSRV:ORG1).

For example, you could add the following line to your Windows
Registry to set the SQLNET parameter:

Parameter Name Parameter Value(s)

SQLNET DBNAME Mktg_SRV X:Server1

Note:  If you define a parameter two or more times, only the
first value is used.

To set Oracle–specific Windows 95 Registry parameters, use the
REGEDIT.EXE application to edit the Windows Registry. Oracle–specific
parameters are located in
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE.

To edit a parameter, double–click the value of the parameter.

To add a new parameter (for example, SQLNET DBNAME <alias>):

1. Point to New under the Edit item in the Windows Registry Editor
and choose String Value. The system adds the new value, assigns it
a temporary name, and highlights the value.

2. Type the name of the parameter to be set and press [Enter].

3. With the new value name still highlighted, choose Modify from the
Edit menu to bring up the Edit String dialog box.

4. Enter the parameter value in the Value data field. Press [Enter], or
click  OK.

Note:  Do not use the equals sign (=).

Example:

To add a new SQLNET alias (MYDB), provide the value name as
SQLNET DBNAME MYDB, then insert the value for the connect string
for the alias (for example, P:MY_CORPSRV:ORG1).

For example, you could add the following line to your Windows
Registry to set the SQLNET parameter:
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Parameter Name Parameter Value(s)

SQLNET DBNAME Mktg_SRV X:Server1

Windows NT/95 Registry Parameter Descriptions

The following list describes the Windows NT/95 Registry parameters
and their default values.  Acceptable parameter name abbreviations
appear in parentheses.

Windows NT/95 Default: not set automatically

Legal Values:  any valid SQL*Net driver prefix

This parameter specifies the SQL*Net driver and SQL*Net parameters
(complete database string) to use when no communications driver is
specified upon loading SQL*Plus.  This parameter enables the DBA to
define a ”default” network connection.  When the user logs on without
specifying any network parameters, ORACLE uses the LOCAL
connection.  Thus, the distributed database is made invisible to the user.

You can reset this parameter on the command line at any time.

Additional Information:  For more information about the
driver prefixes and SQL*Net parameters that are valid for
Windows NT/95, see the Installation Guide or Getting Started for
your SQL*Net driver.

Default: AMERICAN_AMERICA.WE81508859P1

Legal Values:  See the accompanying Release Notes for a current list of
available values.

The NLS_LANG parameter sets the language in which message files
appear.  The syntax for NLS_LANG is as follows:

Parameter Name
NLS_LANG

Parameter Value(s)
language_territory.char_set

where:

language specifies the language and its conventions for displaying
messages and day and month names.
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territory specifies the territory and its conventions for calculating week
and day numbers.

char_set specifies the character set used for the UPPER, LOWER, and
INITCAP functions, and the type of sort used by an ORDER BY query.
This argument also controls the character set used for displaying
messages.

Default: \ORANT (or \ORAWIN95) on the drive where you boot
your PC

Legal Values:  any directory on any drive

This parameter specifies the home directory in which Windows NT/95
Oracle products are installed.

Default:  \ORANT\PRO15 (or \ORAWIN95\PRO15)

Legal Values:  any directory on any drive

This parameter specifies the location of the SQLUS.MSB message file.
The SQLUS.MSB file is used by any precompiled Oracle Product.  (This
release of SQL*Plus is not precompiled.)

Note:  SQLUS.MSB is the name of the American English file.  If
you are not using the American English version of the Required
Support Files, the name of this file may vary.

The first three characters of this parameter, PRO, stand for the
precompiler, such as Pro*C, Pro*COBOL, and PRO*Fortran.  The
remaining characters correspond to the current version of the
SQLUS.MSB message file.  Other ORACLE tools and subsequent
releases of the Required Support Files use a different version of this
message file.

Default:  \ORANT\PLUS33 (or \ORAWIN95\PLUS33)

Legal Values:  any directory on any drive

This parameter specifies the location of the SQL*Plus files, including the
help scripts and the GLOGIN.SQL file.  In addition to searching the
directory specified by the PLUS33, SQL*Plus will also search the current
directory for SQL*Plus files.

The first four characters of this parameter, PLUS, stand for SQL*Plus.
The remaining characters correspond to the current version of SQL*Plus.
Subsequent releases of SQL*Plus may use a different parameter to
specify the SQL*Plus directory to enable you to keep multiple versions
of SQL*Plus on your PC.
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Default:  \ORANT\RDBMSXX (or \ORAWIN95\RDBMSXX)

Legal Values:  any directory on any drive

This parameter specifies the location of three message
files: LCDUS.MSB, ORAUS.MSB, and SOSDUS.MSB.

Note:  LCDUS.MSB, ORAUS.MSB, and SOSDUS.MSB are the
names of the American English files.  If you are not using the
American English version of the Required Support Files, your
file names may vary.

The first five characters of this parameter, RDBMS, stand for ORACLE
RDBMS.  The remaining characters correspond to the current version of
the RDBMS message files.  Other ORACLE tools and subsequent
releases of the Required Support Files may use different versions of
these message files.

Default:  not set automatically

Legal Values:  any valid SQL*Net driver prefix and parameters

This parameter specifies the default and remote SQL*Net driver to use
when connecting via a local database.  The parameter can include the
default SQL*Net parameters (complete database string).  For example:

Parameter Name
REMOTE

Parameter Value(s)
P:PIPER:DBS1

where:

P: is the network prefix for Named Pipes.

Piper is the server name, and DBS1 is the database instance name.

If a user logs on and specifies a connection with an explicit driver prefix
matching the one specified in REMOTE, but specifies no SQL*Net
parameters, the parameters specified in REMOTE are used.  This
parameter enables the DBA to define a ”normal” network connection for
which the SQL*Net user need not specify connection parameters.

You can reset this parameter on the command line at any time.

Default:  not set automatically

Legal Values:  any valid network alias/network prefix combination

This parameter allows you to set a unique alias for each server on your
network or distributed network.  By setting multiple aliases you can
refer to connect strings by simple names or mnemonic conventions; you
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need not remember the complete connect string for each one.  The
following is the general syntax for SQLNET:

Parameter Name
SQLNET DBNAME server_alias

Parameter Value(s)
<a valid connect_string >

To use the server specified in SQLNET, you must enter the alias.  For
example, if you had set

Parameter Name
SQLNET DBNAME Mktg_SRV

Parameter Value(s)
X:Server1

you would access the database from within SQL*DBA by typing:

SQLDBA> CONNECT SCOTT/TIGER@Mktg_SRV;

You can include multiple SQLNET parameters in the Windows NT/95
Registry to define multiple network aliases.

Default:  \ORANT\DBS (or ORAWIN95\DBS)

Legal Values:  any directory on any drive

This parameter specifies the location of SQL scripts.  In addition to
searching the directory specified by the SQLPATH parameter, SQL*Plus
will also search the current directory for SQL scripts.

Note:  SQL*Plus uses the PLUS33 parameter to specify the
location of the  GLOGIN.SQL script.  Refer to ”PLUS33” earlier
in this Appendix for more information.

When you set the SQLPATH parameter, note that directories can be
concatenated with a semicolon (;).  For example:

Parameter Name
SQLPATH

Parameter Value(s)
C:\ORANT\DATA;C:\ORANT\ DBS>

Default:  \ORANT\DBS (or \ORAWIN95\DBS)

Legal Values:  any directory on any drive

This parameter specifies the location of the UIWUS.MSB message file.
In addition to searching the directory specified by the TK20 parameter,
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SQL*Plus will also search the current directory for the UIWUS.MSB
message file.

Note:  UIWUS.MSB is the name of the American English file.  If
you are not using the American English version of the Required
Support Files, the name of this file may vary.

The first two characters of this parameter, TK, stand for Oracle toolkit.
The remaining characters correspond to the current version of the Oracle
toolkit.  Other ORACLE tools and subsequent releases of the Required
Support Files may use a different version of this message file.



Index –  1

Index

Symbols
@ command, 4 – 4

A
ASCII file, LOGIN.SQL, 4 – 3

B
Blocks, PL/SQL, 1 – 2

C
CD–ROM, and online documentation, 2 – 8
Commands, 1 – 2

SQL*Plus, 4 – 4
CONFIG file, setting parameters in, A – 2, 

A – 3
CONFIG parameters, managing

how to set, A – 2, A – 3
when to set, A – 2

CONFIG.ORA, A – 6
Creating, demonstration tables using

SQL*Plus, 4 – 2

D
DEMOBLD file, 4 – 2
Demonstration tables, for SQL*Plus, 4 – 2

Documentation, online, 2 – 8

F
Function key assignments. See Key

assignments

I
Installation, 2 – 3–2 – 8
Installing SQL*Plus, 2 – 6–2 – 8

K
Key assignments for, SQL*Plus, 4 – 3

L
LOCAL parameter, A – 4
LOGIN.SQL file, 4 – 3

N
NLS_LANG parameter, A – 4

O
Online documentation, 2 – 8



Index –  2 SQL*Plus User’s Guide for Windows NT/95 

ORACLE home directory, LOGIN.SQL file, 
4 – 3

ORACLE_HOME parameter, A – 5
Output, Query results, 1 – 2

P
Path search

See also SQLPATH
in SQL*Plus, 4 – 4

PL/SQL, 1 – 2
PLUS33 parameter, A – 5
PRO15 parameter, A – 5

Q
Queries, 1 – 2
Query results, 1 – 2

R
RDBMSnn parameter, A – 6
REMOTE parameter, A – 6
Removing Oracle Products, 2 – 8
Reports, 1 – 2

S
Setting up the Oracle Installer, 2 – 3
SQL database language, 1 – 2
SQL*Plus

basic concepts, 1 – 2

demonstration tables, building, 4 – 2
executing commands from, 4 – 4
installing, 2 – 6–2 – 8
key assignments, 4 – 3
LOGIN.SQL file, 4 – 3
overview, 1 – 2
who can use, 1 – 3

SQLNET parameter, A – 6
SQLPATH parameter, A – 7
START command, 4 – 4

T
Tables, 1 – 2
Tables, demonstration. See Demonstration

tables
TK20 parameter, A – 7

W
Windows Registry, A – 1, A – 4
Windows Registry parameters

LOCAL (LOC), A – 4
NLS_LANG, A – 4
ORACLE_HOME, A – 5
PLUS33, A – 5
PRO15, A – 5
RDBMS70, A – 6
REMOTE (REM), A – 6
SQLNET, A – 6
SQLPATH, A – 7
TK20, A – 7



Reader’s Comment Form

Name of Document:  SQL*Plus User’s Guide for Windows NT/95 
Part No. A43686–1

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness
of this publication.  Your input is an important part of the information used for revision.

• Did you find any errors?

• Is the information clearly presented?

• Do you need more information?  If so, where?

• Are the examples correct?  Do you need more examples?

• What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter,
and page number below:

Please send your comments to:

Desktop Documentation Manager
Oracle Corporation
Workgroup Solutions Division
P.O. Box 659107
500 Oracle Parkway
Redwood Shores, CA 94065

If you would like a reply, please give your name, address, and telephone number below:

Thank you for helping us improve our documentation.
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